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ÖNSÖZ 
 

Su kaynaklarının geliştirilmesi, ekonomik kalkınma ve sosyal hayata doğrudan katkı 

yapmaktadır. Bu çerçevede, ekonomik ve sosyal aktivitelerin sürmesi ve gelişmesi yeterli 

miktar ve kalitede su kaynağına sahip olmaya bağlıdır. Nüfus artışına paralel olarak içme-

kullanma, sanayi ve sulama suyu ile enerji talebi gittikçe artmaktadır. Bu da su kaynaklarının 

sürdürülebilir yönetimini gerekli kılmaktadır.  

Dolayısıyla, günümüzde su kaynaklarının sürdürülebilir yönetimi en önemli gündem 

maddelerinden birini oluşturmaktadır. Bu bağlamda, mevcut su kaynaklarından daha etkin 

yararlanılabilmesi ve çevresel problemlerin azaltılabilmesi bakımından “Entegre Havza 

Yönetimi” tüm dünyada önem kazanmıştır.  

Ülkemiz su kaynaklarının geliştirilmesinden sorumlu olan Devlet Su İşleri Genel 

Müdürlüğü’nün (DSİ) ana hedefi “su kaynaklarının en verimli şekilde kullanılması"dır. DSİ, bu 

hedefe ulaşmak için çalışmalarında gelişen teknolojileri kullanmaktadır.  

Teknolojinin temeli olan bilgi, sistematik bir şekilde kullanıldığı ve yönetildiği takdirde daha 

da faydalı olmaktadır. Bilginin "etkin" bir biçimde yönetilmesi için tasarlanan Coğrafi Bilgi 

Sistemleri (CBS), karar verme aşamasında etkin rol oynamaktadır.   

Su kaynaklarının planlamasına temel teşkil eden su toplama havzalarının belirlenmesinde 

CBS kullanımı büyük önem arz etmektedir. Farklı mühendislik disiplinlerinin bir araya gelerek 

üretim yapması çalışmalarımızda verimliliği daha da arttırmaktadır. Bu da CBS sayesinde 

olmaktadır.  

Bu kapsamda Teknoloji Dairesi Başkanlığı tarafından gerçekleştirilen bu çalışmanın 

çalışanlarımıza faydalı olmasını ve bu tür çalışmaların devam etmesini temenni ederim. 
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GİRİŞ 
 

Su, insanoğlunun hayatını sürdürebilmesi ve çevrenin fonksiyonlarını yerine getirebilmesi için 

temel bir ihtiyaç maddesidir. Artan nüfus, gelişen sanayi ve iklim değişikliği sınırlı miktarda 

olan su kaynakları üzerinde baskı oluşturmaktadır. 

Günümüzde su kaynaklarına yönelik baskıların daha karmaşık hale gelmesi, alternatif 

çözümler üretilmesi konusunda teknoloji kullanımını gerektirmektedir. “Sistemi tanımıyorsan 

yönetemezsin” prensibinden hareketle havza bazında yönetilen su kaynakları için nehir 

havzasının belirlenmesi sistemi tanımaya yönelik ilk adımı oluşturmaktadır. İlk bölümde 

zamana ve mekâna ait verilerin yönetimi gerçekleştiren CBS’nin önemli bir bileşeni olan 

ArcHydro kullanılarak su toplama havzalarının belirlemesine çalışılmıştır. Hidrolojik verileri 

içeren zaman serilerinin yönetiminde büyük kolaylık sağlayan ArcHydro ile zamana bağlı 

veriler mekânsal özelliklerle ilişkilendirilerek yeryüzünde suyun hareketini belirlemek 

mümkün olmaktadır.   

Noktasal yağış değerlerinden alansal yağış değerlerinin hesaplanması için kullanılan Thiessen 

Poligon Metodu ikinci bölümünde yer almaktadır. 

Üçüncü bölümde belirlenen su kotlarına göre depolama tesislerinin rezervuar hacimleri 

belirlenmiş ve kot-alan-hacim grafiği için veri hazırlanması ise dördüncü bölümde yer 

almaktadır. Son bölümde meteorolojik istasyonların havzayı ne ölçüde temsil ettiğini ortaya 

koyan kot-alan grafiği için veri sağlanmıştır.  

Ülkemiz su kaynaklarının yönetiminde söz sahibi olan DSİ’nin diğer bir özelliği de eğitici bir 

kurum olmasıdır. Bu nedenle çalışanlarımızın bilgi ve birikimlerini gelecek nesillere aktarması 

DSİ’nin geleceği açısından büyük önem taşımaktadır.     

Bu çalışmayı hazırlayarak Ülkemizin su kaynakları yönetiminde gelecekte söz sahibi olacak 

gençlerimize destek olmayı amaç edinen Nesibe Gülşah Güreşci, Kemal Seyrek ve Ahmet 

Hamdi Sargın’a teşekkür ederim. 
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KAPSAM 
 
Dünyadaki hızlı nüfus artışına, kentleşme ve sanayileşmeye bağlı olarak su kullanımı gün 

geçtikçe artmasına rağmen kullanılabilir su kaynakları potansiyeli sabit bulunmaktadır. Diğer 

taraftan, tarımsal faaliyetlerin genişlemesi, sanayileşme, kentleşme ile küresel ısınma ve 

iklim değişikliği mevcut su kaynakları üzerinde büyük bir baskı yaratmaktadır. Dolayısıyla, 

günümüzde su kaynakları yönetimi çözümlenmesi gereken en önemli problemlerden birini 

oluşturmaktadır. Bu bağlamda, mevcut su kaynaklarından daha etkin yararlanılabilmesi ve 

çevresel problemlerin azaltılabilmesi bakımından “Entegre Havza Yönetimi” tüm dünyada 

önem kazanmaktadır.  

“Entegre Havza Yöntemini” gerçekleştirebilmek için ise havza ve alt-havza alanlarının ülke 

bazında sistematik olarak tanımlanmasına ihtiyaç duyulmaktadır. Ülkemizde yapılan 

çalışmalar neticesinde 25 temel havza tespit edilmiş olup su kaynakları planlaması ve 

yönetimi söz konusu bu 25 temel havza üzerinden yapılmaktadır. Alt havzalar ise hazırlanan 

projeler kapsamında genelde ele alınmakta ve proje ihtiyaçları doğrultusunda 

belirlenmektedir. Bu nedenle ülke genelini kapsayan sistematik bir havza ve alt-havza 

çalışmasının yapılmasına ve havza sınırlarının mevcut güncel haritalar ile yeni teknolojik 

gelişmelerinde kullanılarak yeninden gözden geçirilmesine ihtiyaç duyulmaktadır.  

Geçmişte havza sınırlarının bulunmasında yoğun olarak kağıt ortamdaki topoğrafik haritalar 

kullanılmış olup topoğrafik haritalar üzerinden eşyükselti eğrileri ile tepe noktaları takip 

edilerek su ayırım çizgileri çizilmiş ve havza sınırları ile alt-havza sınırları belirlenmiştir. 

Hazırlanan havza veya alt-havza sınırlarına ait alanlar ise planimetre ile ölçülmüştür. Son 

yıllarda ise özellikle Bilgi Teknolojilerinde meydana gelişmelere bağlı olarak Coğrafi Bilgi 

Sistemi söz konusu işlemlerin yapılmasında yoğun olarak kullanılmaya başlanılmıştır. Coğrafi 

Bilgi Sistemi kullanılarak havza ve alt-havza alanlarının tespit edilmesine yönelik hem teorik 

bilgiler hem de en çok kullanılan yazılımlardan biri olan ArcHydro uygulaması ilk bölümde  

yer almaktadır. 

Bu çalışmada Porsuk Nehri su toplama alanının belirlenmesi, Bahçelik Barajı drenaj alanına 

düşen ortalama yıllık toplam yağış miktarının hesaplanması, maksimum su kotluna göre aktif 

hacmin belirlenmesi, rezervuara ait kot-alan-hacim grafiği ve drenaj alanı kot-alan grafiği için 

veri hazırlanması ArcGIS 10 kullanılarak gerçekleştirilmiştir.  

Konular makale niteliğinden ziyade uygulama yapan mühendislere ışık tutması açısından ders 

notları şeklinde açıklanmıştır. 
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1. ARCHYDRO İLE SU TOPLAMA ALANLARININ BELİRLENMESİ 

1.1 Giriş  
 
Yağışlardan kaynaklanan yüzeysuyu akımını toplayan saha olarak tanımlanan “su toplama 
alanı”nın tespit edilmesi özellikle; 
 

 Baraj ve gölet gibi su yapılarının planlamasında su yapısının aks yerinin ve kret 
yüksekliğinin tayin edilmesinde,  

 Akarsu üzerinde kurulacak olan herhangi bir akım gözlem istasyonundan geçebilecek 
su miktarının hesaplanmasında istasyon yerinin belirlenmesinde, 

 Yapılacak herhangi bir taşkın önleme tesisinin boyutlandırılmasında önem arz 
etmektedir.   

 
Coğrafi Bilgi Sistemi kullanılarak havza sınırlarının belirlenmesi; arazi verilerini ön işleme ve 
su toplama alanı işlemi olmak üzere iki aşamada gerçekleştirilmektedir. 
 
Arazi Verilerini Ön İşleme’de (ArcHydro Terrain Preprocessing) yer alan bütün adımlar 
aşağıda yer aldığı şekilde sırası ile yapılmalıdır. Bu işlemlerin tamamı Su Toplama Alanı 
İşlemleri (Watershed Processing) fonksiyonundan önce tamamlanmalıdır. Aşağıdaki Çizelge 
1’de verileri işlemede izlenecek adımlar görülmektedir. Sarı alanlar işlemi, yeşil alanlar ise 
işlemlerden elde edilen çıktıları göstermektedir. Çizelgeden de görüleceği gibi bir işlemin 
çıktısı bir sonraki işlem için girdi olmaktadır. Akım Yönü çıktısı olan “Fdr” katmanı ise Nehir 
Bölümleme, Drenaj Çizgilerini Belirleme ve Su Toplama Alanı Oluşturma için girdi olduğu 
görülmektedir. 
 

 
 
Çizelge 1. Arazi verileri ön işleme işlem sırası 
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Arazi verilerini ön işleme tabi tutmadan önce kullanılacak veriler, çalışma dizinin belirlenmesi 
ve ArcMap’e veri yükleme ile ilgili olarak kısa bilgi verilecektir. Son olarak nehir, depolama 
tesisi ve göl için su toplama alanlarının belirlenmesine yönelik uygulamalar 
gerçekleştirilecektir.  
 
1.2 Sayısal Yükseklik Modeli – SYM (Digital Elevation Model - DEM)  
 
Bir sayısal yükseklik modeli (DEM) yeryüzünün sürekli bir biçimde değişen topografik yüzeyini 
3 boyutlu gösteren bir yapıdır. Bu model, 3 boyutlu uygulamalar için genel bir veri kaynağıdır. 
Sayısal yükseklik modeli, raster veri özelliğinde olup bir arazi yüzeyini en iyi temsil eden 
düzenli/düzensiz aralıklarla yapılmış çok sayıda yükseklik ölçümünden oluşmaktadır. Kısaca, 
her bir pikselin yükseklik (kot) değerine sahip olan sürekli yüzeylere dönüştürülmesidir.  
 
Şekil 1’de DEM’in hücresel boyutu ile yükseklik değerlerine sahip piksel dağılımı 
görülmektedir. Şekilde görüldüğü gibi her bir piksel sahip olduğu yükseklik değerine bağlı 
olarak temsil edilmektedir.  
 

 
 
Şekil 1. DEM’in hücresel boyutu 
 
DEM verisi sayısal ortama aktarılmış münhanilerden veya uydu görüntülerinden elde edilir. 
Uydu görüntüleri ve münhanilerden elde edilen DEM verileri arasındaki fark, çözünürlük 
farkıdır. Bu çalışmada SRTM veri seti kullanılmıştır. 
 
1.3 Arazi Verilerini Ön İşleme (ArcHydro Terrain Preprocessing) 
 
” DEM yenileme” ve “boşlukları doldurma” başlangıçtaki DEM verisinin kalitesine bağlı olarak 
gerekli olmayabilir. Programın raster veriden üreteceği “drainage line” ile gerçek nehir ağı 
örtüşmeyebilir. Bunun için mevcut nehir ağı verileri güvenli ise işleme başlamadan önce 
“burn stream slope” komutu ile nehir ağının bulunduğu yerlerde yükseklik değeri azaltılır. 
 
1.3.1 DEM yenileme (DEM Reconditioning) 
 
Bu fonksiyon AGREE metodu kullanarak DEM verilerini yeniden düzenlemektedir. DEM 
yenileme, raster veri olan yükseklik değerlerinin vektör veri olan nehir ağı ile daha uyumlu 



 
 
 

3 
 

olmasını sağlar. Bu da nehir ağı verilerinin, DEM verilerinden daha güvenilir ve doğru olması 
gerçeğini açığa çıkarır.  
Bir SYM verisine bu fonksiyonu uygulamanın temel amacı, doğruluğu yüksek nehir ağı 
verilerini dikkate alarak daha yüksek doğruluklu bir SYM elde etmektir. Yapılacak 
çalışmalarda, kullanılacak olan raster verinin (SYM) doğruluğu ne kadar yüksek olursa sonuç 
ürünü olan su toplama havzaları da o derecede sağlıklı olacaktır.   
 
Nehir ağı verileri, nehire ait yükseklik değerlerini de içermelidir. Fonksiyonun girdi olarak 
DEM ham verisine ve nehir ağı gibi bir feature class’a ihtiyaç vardır.  
 
 Terrain Preprocessing → DEM Manipulation → DEM Reconditioning seçilir. 

 
Raw DEM için çalışılacak orijinal DEM dosyası ve AGREE stream için nehir ağı dosyası seçilir. 
Agree parametreleri şekilde görüldüğü gibi girilir. Program tarafından 1000 olarak varsayılan 
Sharp drop/raise parametresi değiştirilir. AgreeDEM ise çıktı dosyası olup bu dosya elde 
edilecek su toplama alanının DEM verisidir.    
 

 
 
OK düğmesine basılır. İşlem 2-3 dakika sürebilir ve başarı ile tamamlandığında mesaj 
kutusunda “…processing successfully completed” ifadesi yer alır.  
 
Stream buffer, Smooth drop/raise ve Sharp drop/raise fonksiyonları seçeneğe bağlıdır. Program 
tarafından varsayılan değerler kabul edilir veya aşağıda belirtildiği gibi hesaplanabilir. 
 

 Stream buffer: Yüzey yenilemesinin gerçekleşeceği alansal yayılımı kontrol eder ve 
yenilemenin yapılacağı hücre sayısı girilir. Yaklaşık olarak raster veri ile vektör veri 
arasındaki hata ölçeğine eşittir. Hata ölçeği original DEM’den elde edilen nehir yatağı 
ile vektör veri olan nehir ağlarının karşılaştırılması ile hesaplanır. Örneğin 500 
metrelik alanda yüzey yenilemesi yapılacak ve bu yüzeyin grid boyutu 100 metre ise 
bu haneye hücre sayısı 5 olarak girilir. 
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 Smooth drop/raise:  Yükseklik değerleri düşürülen/arttırılan vektörlere karşılık gelen 
mesafe için kullanılır. Girilen sayı pozitif ise değeri düşey ölçekte düşürmeyi veya sayı 
negatif ise arttırmayı belirtir. Bu değer buffer bölge sınırı ile düşürülen/arttırılan 
vektör arasında yer alan buffer bölge için DEM dosyasındaki değerlerden 
enterpolasyon yaparak buffer bölgesindeki değerlerin hesaplamasında kullanılır. 
Aşağıdaki formül ile hesaplanır; 

 
Smooth drop/raise mesafesi = tampon bölge içindeki ortalama yüzey eğimi * tampon 
bölge genişliği * etki faktörü 

 
Etki faktörü, buffer bölgesindeki bozunmanın büyüklüğünü ifade etmektedir. “0” ise 
veriler aynen kalmakta ve tampon bölgedeki eğim orijinal eğime çok yakın 
olmaktadır. Faktörün “0,5” olması halinde tampon bölge içindeki eğimin iki kat 
arttırılacağını belirtir. Bu formülden elde edilen değer, yükseklik değerlerinin 
düşürüleceği/arttırılacağı miktar hakkında yaklaşık bilgi vermektedir.  
 

 Sharp drop/raise: Bu fonksiyon, bir önceki işlem gerçekleştirildikten sonra yükseklik 
değerleri düşürülen/arttırılan vektörlere karşılık gelen hücreleri kontrol etmektedir. 
Girilen sayı pozitif ise değeri düşey ölçekte düşürmeyi veya sayı negatif ise arttırmayı 
belirtir. Gerekli olduğunda kanal kazmak veya duvar inşaa etmek ile eşdeğerdir. 

  
1.3.2 Boşlukları doldurma (Fill Sinks) 
 
Bu fonksiyon DEM’de yer alan boşluk hatalarının giderilmesi için kullanılır. Bir hücre daha 
fazla yükseklik değerine sahip olan hücreler ile çevrildiği takdirde su, yükseklik değeri az olan 
bu hücreye doğru akacaktır (Şekil 3).  
 

 
 
Şekil 3. DEM’de oluşabilen boşluk 
 
DEM’de yer alan boşluklar doldurulmadığı takdirde yüzey akışı oluşamaz. Bu nedenle 
boşlukların doldurulması gereklidir. Fonksiyon bu problemi ortadan kaldırmak için yükseklik 
değerlerini yeniden düzenler (Şekil 4). 
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Şekil 4. Boşlukların doldurulması 
 
 Terrain Preprocessing→Data Manipulation→Fill Sinks seçilir. 

 

Orijinal DEM dosyası için yenileme yapıldı ise bir önceki işlemin çıktı dosyası bu işlemin girdi 

dosyasıdır. Bu işlemde Hydro DEM hanesinde yer alan “Fil” katmanı çıktıdır.  

 Fill All: Bu seçenek işaretlenerek bütün boşluklar doldurulur. 

 

Deranged Polygon, Use IsSink Field ve Fill Threshold fonksiyonları seçeneğe bağlıdır. Program 

tarafından varsayılan değerler kabul edilir veya aşağıda belirtildiği gibi hesaplanabilir. 

Seçenekler: 

 Deranged Polygon: Bu özellik doldurulmayacak boşluklar var ise bu tür boşlukları 

tanımlamak için kullanılır.  

 Use IsSink Field: Deranged Polygon kullanılacak ise seçilir. Doldurulmayacak boşlukları 

tanımlamak için bu seçenek işaretlenir.  
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 Fill Threshold: Doldurulmayacak boşluklar için kullanılır. Bu haneye girilen eşik 

değerden daha az derin olan boşluklar doldurulmaz. Seçilmek istenildiği takdirde 

işaretlenmelidir.  

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra bu katman haritaya 

eklenir.  

1.3.3 Akım yönü belirleme  (Flow Direction) 
 

Bu fonksiyon verilen grid sistemi için akım yönünü hesaplamaktadır. Hücrede yer alan değer, 

bu hücreye komşu 8 hücreden yükseklik değeri en az olana doğru su akım yönünü 

göstermektedir. 

Şekil 5a’da görüldüğü gibi her bir gridde yükseklik değeri yer almaktadır. Su akışı en düşük 

yükseklik değerine sahip gride doğru olacaktır (Şekil 5b). 

 

77 66 59 

63 54 47 

68 65 32 
 

 

(a)                                                                                  (b) 

Şekil 5. Su akış yönü 

Akış yönünü bilgisayar ortamında ifade etmek için “8 yönlü akım modeli” kullanılmaktadır. 

Gridin akım yönünü göstermek için Şekil 6’da yönlere bağlı olarak gösterilen rakamsal 

değerler kullanılmaktadır. Örneğin bir hücreden akımın doğu yönünde olduğunu belirtmek 

için 1, kuzeybatı yönünde olduğunu belirtmek için 32, güneydoğu yönünde olduğunu 

belirtmek için 2 kullanılır. 

 
 

 

KB Kuzey KD 

Batı  Doğu 

GB Güney GD 

Şekil 6. Akım yönleri 
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Aşağıdaki Şekil 7a’da hücrelere ait yükseklik değerleri, Şekil 7b’de akım yönleri ve Şekil 7c’de 

ise bu yönlerin ArcHydro programında kullanılacak olan veri tablosu görülmektedir. 

 

77 66 59 

63 54 47 

68 65 32 

 

   

   

   
 

2 2 4 

1 2 4 

128 1 2 

                      (a)                                                   (b)                                                      (c) 

Şekil 7. Akım yönünün matematiksel ifadesi 

 Terrain Preprocessing Flow Direction seçilir. 

 
Hydro DEM için girdi dosyasının bir önceki işlemin çıktı dosyası olan “Fil” olduğu teyit edilir. 

Bu işlemde “Fdr” katmanı çıktıdır. 

 

Outer Wall Polygon fonksiyonu seçeneğe bağlıdır. Program tarafından varsayılan değer olan 

“Null” ifadesi ile boş bırakılır veya aşağıda belirtildiği gibi belirlenir.  

Seçenek: 

 Outer Wall Polygon: Çalışılan veri içerisinde sadece belirli bir kısmın çalışılması 

istenildiği takdirde çalışılacak alan poligon olarak tanımlanıp bu poligon sınırları 

içerisindeki kısmı Flow Direction Grid katmanından seçerek işleme tabi tutulur. 

Poligon alanı dışındaki alan işlem dışı bırakılır.  

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra bu katman haritaya 

eklenir. Katman büyütüldüğünde hücrelerin akım yönüne bağlı olarak farklı değerlere ve 

renklere sahip olduğu görülür. Renk tonları “8 yönlü akım modeli”ne göre akım yönlerini 

ifade etmektedir.  
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1.3.4 Kümülatif akım hesaplama  (Flow Accumulation) 
 

Bir hücrenin su toplama alanında yer alan hücre sayısını hesaplar. Böylece su toplama alanı 

ve nehir kolları belirlenmeye başlar.  

 

   

   

   
 

a b c 

d e f 

g h i 
 

0 0 0 

0 3 2 

0 0 8 
                          (a)                                                (b)                                                   (c) 

Şekil 8. Kümülatif akım yönü 

Şekil 8a’da akım yönüne bağlı olarak hücreler arası akım ilişkileri görülmektedir. a,b,c,d,g ve 

h hücrelerine (Şekil 8b) doğru akım oluşmayacağından bu hücrelere 0 girilir. e hücresine 3 

hücreden, f hücresine ise 2 hücreden akış olmaktadır. i hücresine ise en düşük yükseklik 

değerine sahip olduğundan 8 hücreden akış gerçekleşmektedir. Böylece her bir hücrenin su 

toplama alanında kalan hücre sayısı belirlenir (Şekil 8c).   

 Terrain Preprocessing Flow Accumulation  seçilir. 

 

Flow Direction Grid için girdi dosyasının bir önceki işlemin çıktı dosyası olan “Fdr” olduğu 

teyit edilir. Bu işlemde “Fac” katmanı çıktıdır. 
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OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra bu katman haritaya 

eklenir.  

Menba-mansap ilişkisini daha rahat gözlemleyebilmek için sembolojiden sınıflandırma 

yapılır. 

 

Haritada, menbadan mansaba doğru renk tonunun açık renkten koyu renge doğru su 

toplama alanı büyüklüğüne bağlı olarak değiştiği gözlenir. 
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Ayrıca, Fac grid üzerinde nehir ağında herhangi bir noktaya  düğmesini kullanarak 

tıkladığımızda, bu noktaya ait toplam Fac gridi sayısı ile bir hücre alanının çarpımı bu 

hücrenin su toplama alanını vermektedir.  

 
1.3.5 Nehir tanımlama (Stream Definition) 

 

 Terrain Preprocessing Stream Definition seçilir. 

 

Flow Accumulation Grid için girdi dosyasının bir önceki işlemin çıktı dosyası olan “Fac” 

olduğunu teyit edilir. Bu işlemde “Str” katmanı çıktıdır 

 

Su toplama alanı için eşik olarak varsayılan değer ekranda gözükür. Bu değer maksimum 

kümülatif akımın % 1’ini temsil etmektedir.  Bir dere alanı üretmek için eşik su toplama alanı, 

toplam hücre sayısı ile bir hücre alanının çarpımına eşittir. Daha küçük eşik değer daha yoğun 

nehir ağına ve daha fazla sayıdaki su toplama alanına karşılık gelmektedir.  

Aşağıdaki örnekte eşik değer alan 25 km2 olarak alınmıştır. Number of cells veya Area ‘dan 

herhangi birisi girildiğinde program diğerini otomatik olarak düzenlemektedir. 
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OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra Str katmanı haritaya 

eklenir. Str grid katmanında nehirin yer aldığı bütün hücreler “1” değerini içermektedir. “1” 

değerine sahip hücreler aşağıdaki şekilde gözükür. 

 

 
1.3.6 Nehir bölümleme (Stream Segmentation) 
 

Kendine özgü tanımlama numarasına sahip nehir bölümlerinin grid sistemini oluşturur. Belirli 

bir bölümdeki bütün hücreler aynı grid koduna sahiptir ve bu kodlar o bölüme özgüdür. 
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 Terrain Preprocessing Stream Segmentation seçilir. 

 

 

Sink Watershed Grid ve Sink Line Grid fonksiyonları seçeneğe bağlıdır. Program tarafından 

varsayılan değer olan “Null” ifadesi ile boş bırakılır veya aşağıda belirtildiği gibi belirlenir.  

Seçenekler; 

 Sink Watershed Grid: Nehir çizgilerinin üretilemediği boşlukların su toplama alanını 

belirlemek için kullanılır.  

 Sink Line Grid: Nehir çizgilerinin üretilemediği alanları belirlemek için kullanılır.  

Flow Direction Grid için Fdr ve Stream Grid için Str katmanları girdi, StrLnk katmanı ise 

çıktıdır. 

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra StrLnk katmanı aşağıdaki 

şekilde haritaya eklenir. Örnekte nehir ağının yoğunluğuna bağlı olarak 15 farklı bölümleme 

yapılarak 15 su toplama alanı elde edilmiştir.    
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Her bir nehir çizgisinin ayrı değere sahip olduğuna dikkat edilmelidir. 

1.3.7 Su toplama alanı oluşturma (Catchment Grid Delineation) 
 

Bu fonksiyon, her bir hücre için hücrenin ait olduğu alt su toplama alanını gösteren değere 

(grid kodu) sahip bir grid sistemi meydana getirir.  Bu değer 3.6 bölümünde yer alan nehir 

bölümlemesinde tanımlanan alanın sahip olduğu değere karşılık gelir.  

 Terrain Preprocessing Catchment Grid Delineation seçilir. 

 

Flow Direction Grid için Fdr ve Link Grid için StrLnk katmanları girdi, Cat katmanı ise çıktıdır. 

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra Cat katmanı haritaya 

eklenir.  

Özellikler seçeneğinden semboloji ile renklendirme yapıldığında aşağıdaki görüntü elde edilir.  
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1.3.8 Su toplama alanını poligonlama (Catchment Polygon Processing) 
 
Bu aşamadan itibaren gerçekleştirilecek 3 fonksiyon Catchment Polygon Processing, 

Drainage Line Processing ve Adjoint Catchment Processing raster verileri vektör veri 

formatına dönüştürmektedir. 

 Terrain Preprocessing Catchment Polygon Processing seçilir. 

Bu fonksiyon 3.7 bölümünde elde edilen su toplama alan gridini, poligon özelliğine 

dönüştürmektedir. 

CatchmentGrid için girdinin Cat ve Catchment çıktısının ise Catchment olduğunu teyit edilir.  

 

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra poligon özellikteki vektör 

veri Catchment katmanı haritaya eklenir. 
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Bu katmanın öz nitelik tablosu açıldığında her bir su toplama alanının kendine özgü 

HydroID’ye sahip olduğu görülür. Ayrıca her bir su toplama alanı için uzunluk ve alan bilgileri 

de otomatik olarak hesaplanmaktadır. 

 

1.3.9 Drenaj çizgilerini belirleme (Drainage Line Processing) 
 

6. adımda elde edilen Stream Link gridini Drainage Line şekline dönüştürür. Drainage Line’de 
yer alan her bir çizgi, bu çizgiye ait su toplama alanının tanımlayıcısını içermektedir. 

 Terrain Preprocessing Drainage Line Processing seçilir.  

StreamLink Grid ve Flow Direction Grid girdi dosyaları olup StrLnk ve Fdr katmanları kullanılır. 

Drainage Line ise çıktı dosyasıdır. 

 

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra poligon özellikteki vektör 

veri Drainage Line katmanı haritaya eklenir. 
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1.3.10 Bitişik su toplama alanı belirleme (Adjoint Catchment Processing) 
 

Bu fonksiyon Catchment katmanını kullanarak akım yönünde birbirleri ile ilişkili olan su 

toplama alanlarını bir araya getirir. Ana su toplama alanı olmayan her bir su toplama alanı 

için menba alanını ana su toplama alanının girdi noktasına drene eden bir poligon inşa edilir 

ve depolanır.   

 Terrain Preprocessing Adjoint Catchment Processing seçilir. 

Drainage Line ve Catchment girdi dosyaları olup Adjoint Catchment ise çıktı dosyasıdır. 
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OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra poligon özellikteki vektör 

veri Adjoint Catchment katmanı haritaya eklenir. 

1.3.11 Drenaj noktası belirleme (Drainage Point Processing) 

Belirlenen su toplama alanları için drenaj noktalarını tayin eder. 

 Terrain Preprocessing Drainage Point Processing seçilir. 

Flow Accumulation Grid, Catchment Grid ve Catchment girdi dosyalarıdır. Drainage Point ise 

çıktı dosyasıdır. 

 

OK düğmesine basılır. İşlemin başarı ile tamamlanmasından sonra poligon özellikteki vektör 

veri Drainage Point katmanı haritaya eklenir. 
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1.4 Su Toplama Alanı İşlemleri (Watershed Processing) 

1.4.1 Herhangi bir noktanın su toplama alanını belirleme  (Batch Watershed Delineation) 

Girilen bir noktanın (Batch Point) menbasında yer alan su toplama alanını belirler. 

Flow Accumulation, Catchment and DrainageLine veri setleri ekranda olmalıdır. Su toplama 

alanının boşalım kesimi aşağıdaki şekilde görüldüğü gibi büyütülerek tek bir hücre belirlenir. 

Burada amaç su toplama alanındaki suyu drene eden noktayı tayin etmektir. 

 

 
 
 

 

Boşalım noktası belirlenerek Batch Point Generation  tuşuna basıldığında bu noktaya ait 

özellik tablosu oluşturulur.  

Nokta oluşturmada dosya adının BatchPoint olduğu teyit edilir. 

 

OK tuşuna basıldığında belirtilen lokasyonda bir nokta oluşturulur. Aşağıdaki tablo ekrana 

gelir ve bu noktaya ait bilgiler aşağıdaki şekilde girilir;  
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Seçenekler; 

 Name : Noktayı tanımlamak için kullanıcı tarafından girilir.   

 Description : Noktayı tanımlamak için kullanıcı tarafından girilir.   

 BatchDone : “0” seçilirse girilen noktayı dikkate alarak alan belirlemesi yapılır. Bu 

değer “1” girilirse alan belirlemede bu nokta dikkate alınmaz.   

 SnapOn : “1” ise bu fonksiyon işleme dahil edilir. Girilen nokta, drenaj çizgisine yeterli 

derecede yakın ise (yaklaşık 5 hücre mesafede) su toplama alanının drenaj çizgisini 

yakalar. “0” ise drenaj çizgisini yakalamadan belirlenen nokta için su toplama alanını 

tayin eder.  

 Type : “0” değeri bu noktanın boşalım noktası (Outlet) olduğunu “1” ise beslenim 

noktası (Inlet) olduğunu ifade eder.  

Bu işlemlerden sonra  

 Watershed Processing Batch Watershed Delineation seçilir.  

Alanlara ait veriler daha önceki işlemlerden elde edilen çıktılar kullanılarak aşağıda 

gösterildiği gibi girilir. Watershed ve Watershed Point çıktı dosyalarıdır. 
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OK tuşuna basıldığında 1 nokta için işlem yapıldığını gösteren mesaj ekrana gelir.  

 

 

Çıktı yukarıda görüldüğü gibi ekrana gelir. Bu çıktı, DEM ve diğer elde edilen verilerle uyumlu 

olacaktır. 
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EK – 1  Porsuk Çayı Su Toplama Alanı 

SAYISAL VERİ 
 
Bu çalışma kapsamında, SRTM uydu görüntülerinden elde edilen Sayısal Arazi Modeli (DEM) 

kullanılarak Porsuk Çayı’na ait su toplama alanı belirlenmiştir. 
 

DEM olarak SRTM90 uydu görüntülerinden faydalanılmıştır. Porsuk Çayı’nın yer aldığı 

lokasyon yaklaşık olarak belirlendikten sonra Türkiye SRTM DEM verilerinden çalışma alanını 

belirlemek amacı ile poligon katmanı oluşturulmuştur. Bu katman Şekil 1’de kırmızı renkli 

çerçeve olarak görülmektedir.  

 

Şekil 1. SRTM uydu görüntüsü 

ArcTool menüsünden, Data Management Tools/Raster/Raster Processing/Clip seçilerek (Şekil 

2) bütün Türkiye görüntüsünden sadece kırmızı çerçeve içerisindeki alan çalışma için 

belirlenir.  
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Şekil 2. ArcTool menüsü 

ÇALIŞMA DİZİNİNİN BELİRLENMESİ  
 
Arc Hydro Tool ile oluşturulacak bütün vektör veriler yeni bir geodatabase’de depolanır. Yeni 
raster veriler, dataseti veya Data Frame ile aynı isimli alt dizinde program tarafından 
otomatik olarak depolanır. Depolama yeri için yeni bir dizin seçilmek istenirse aşağıdaki yol 
izlenir; 
 

 ApUtilities → Set Target Locations  seçilir (Şekil 3). 
 
 

 
Şekil 3. Alt dizin yeri belirlemede ilk adım  
 

Açılan menüden HydroConfig seçilerek OK tuşuna basılır (Şekil 4). 
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Şekil 4. Alt dizin yeri belirlemede ikinci adım 
 
Burada raster ve vektör verilerin depolanacağı dizinler belirlenir. Raster veriler için dizin adı 

verilirken vektör veriler için ise yeni bir geodatabase oluşturulur ve bu oluşturulan 

geodatabase seçilir.  

Şekil 5‘den görüleceği gibi raster veriler porsuk isimli alt dizinde depolanacak iken vektör 

veriler ise oluşturulan porsuk isimli geodatabase’de depolanacakır.  

 

 
Şekil 5. Alt dizinin belirlenmesi 

 
ARCMAP’E VERİ YÜKLEME 
 

 Add düğmesine basılarak, diyalog kutusundan verilerin yer aldığı konuma gidilir ve 
raster veri olan DEM dosyası ile vektör veri olan nehir ağları katmanı eklenir. 
 
ARAZİ VERİLERİNİ İŞLEME   

ArcHydro Tool/Terrain Preprocessing/DEM Manipulation/Fill Sink ile boşluk doldurma seçilir 

(Şekil 6). 
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Şekil 6.  Boşlukların doldurulması 

Verilerimizi yenileme için sağlıklı bir akarsu verimiz olmadığından DEM Yenileme işlemi 

yapılmamıştır. DEM verisi olarak SRTM görüntüsünden Clip ile seçtiğimiz “porsukdem” 

katmanı kullanılmıştır. Bu katman içindeki bütün boşlukların doldurulması istendiğinden “Fill 

All” seçeneği işaretlenmiştir. Bu işlemin çıktısı ise “porsukfil” katmanıdır. 

 

Şekil 7. Boşlukların doldurulması seçenekleri 
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“porsukfil” katmanı akım yönünün belirlenmesinde girdi olarak kullanılarak “porsukfdr” 

katmanı elde edilmiştir (Şekil 8). Daha önceden hazırlanan “porsukdem” katmanının 

tamamında çalışılacağından “Outer Wall Polygon” seçeneği boş bırakılmıştır.   

 

Şekil 8. Akım yönünün belirlenmesi 

Program tarafından 8 yönlü akım modeline bağlı olarak hesaplanan akım yönleri piksel 

bazında farklı renklerde gözükmektedir. Her bir renk farklı akım yönünü ifade etmektedir 

(Şekil 9).  

 

Şekil 9. Akım yönleri 

 

“porsukfdr” katmanı kümülatif akım yönünün belirlenmesinde girdi olarak kullanılarak 

“porsukfac” katmanı elde edilmiştir (Şekil 10). 
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Şekil 10. Kümülatif akım yönü 

Elde edilen katman için Layer Properties/Symbology  (Şekil 11) kullanılarak akarsu ağının 

akım yoğunluğuna bağlı olarak renklendirilmesi elde edilir (Şekil 12). 

 

Şekil 11. Akarsu ağı için semboloji 
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Şekil 12. Akarsu ağının akım yoğunluğuna bağlı olarak renklendirilmesi  

“porsukfac” katmanı üzerinde  tuşu ile herhangi bir noktaya bastığımızda o noktanın su 

toplama alanında kalan toplam hücre sayısı elde edilir. Bu örnekte seçilen nokta için hücre 

sayısı 388.037 belirlenmiştir (Şekil 13) . Ayrıca hücreler 80,047 m ölçülerinde çözünürlüğe 

(hücre genişliğine-piksel boyutuna) sahip SRTM90 uydu görüntüsü kullanıldığından bu 

noktanın su toplama alanı  80,047 x 80,047 x 388.037 = 2.486 km2 ‘dir. 

 

Şekil 13. Su toplama alanı hesabı 
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“porsukfac” katmanı nehrin tanımlanmasında (nehir çizgilerinin belirlenmesinde) girdi olarak 

kullanılarak (Şekil 14) “porsukstr” katmanı elde edilmiştir (Şekil 15). 

 

Şekil 14. Nehir tanımlama 

Bu örnekte minimum su toplama alanı büyüklüğü akarsu ağının yoğunluğuna bağlı olarak 50 

km2 seçilmiştir. Bundan sonraki işlemlerde de en küçük su toplama alanı 50 km2 olarak 

dikkate alınarak işlem yapılacaktır. Program hücre sayısını ise otomatik olarak 

belirlemektedir (Şekil 14). 

 

Şekil 15. Nehir tanımı katmanı çıktısı 
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“porsukfdr” ve “porsukstr” katmanlarında aynı nehir çizgisi üzerindeki hücrelere aynı kod 

verilerek nehirin bölümlenmesi olan “porsukstrlnk” katmanı elde edilmiştir (Şekil 16). 

“porsukstr” katmanında görüleceği gibi bütün alanda nehir çizgileri üretilebildiği için “Sink 

Watershed Grid” ve “Sink Link Grid” seçenekleri boş olarak seçilmiştir. 

 

Şekil 16. Nehir bölümleme 

Elde edilen katman için Layer Properties/Symbology  (Şekil 17) kullanılarak nehir kollarının 

renklendirilmesi elde edilir (Şekil 18). Burada eşik değer olarak belirlenen 50 km2’lik alan 

göre 341 adet su toplama alanı oluşturulmuştur. 

 

Şekil 17. Nehir bölümleme için semboloji 
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Şekil 18. Nehir bölümlemeye bağlı olarak nehir kollarının renklendirilmesi  

“porsukfdr” ve “porsukstrlnk” katmanları kullanılarak her bir hücrenin yer aldığı su toplama 

alanına kod verilen “porsukcat” katmanı elde edilmiştir (Şekil 19). Şekil 20‘de görüleceği gibi 

341 adet su toplama alanı raster veri olarak belirlenmiştir.  

 

Şekil 19. Su toplama alanı belirleme 
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Şekil 20. Su toplama alanı  

Bu aşamadan itibaren raster veriler vektör veriye dönüştürülmektedir. 

“porsukcat”  katmanı kullanılarak bu katmandaki raster veriler “porsukcatchment” 

katmanında vektör veri haline getirilmiştir (Şekil 21). 

 

Şekil 21. Su toplama alanı vektör veri elde etme 

Elde edilen katman için Layer Properties/Symbology  (Şekil 22) kullanılarak su toplama 

alanının renklendirilmesi elde edilir (Şekil 23). 
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Şekil 22. Su toplama alanları için semboloji 

 

Şekil 23. Su toplama alanları 
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“porsukstrlnk” ve “porsukfdr” katmanları kullanılarak her bir su toplama alanındaki nehir 

çizgileri “porsukdrainageline” katmanında vektör veri olarak belirlenir (Şekil 24). 

 

Şekil 24. Nehir çizgilerinin belirlenmesi 

Şekil 25‘de her bir su toplama alanı ve bu alanda yer alan drenaj çizgileri gözükmektedir. 

 

Şekil 25. Drenaj çizgileri ile su toplama alan sınırları  

“porsukdrainageline” ve “porsukcatchment” katmanları kullanılarak bitişik su toplama 

alanları “porsukadjointcatchment” katmanında (Şekil 26) bir araya getirilir (Şekil 27). 
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Şekil 26. Bitişik su toplama alanları belirleme 

 

Şekil 27. Bitişik su toplama alanları 

Bu aşamadan itibaren bir noktaya ait su toplama alanı belirlenecektir.  

Çalışmada Porsuk Çayı’nın Sakarya nehri ile birleşme noktası seçilerek bu nokta 

“porsukdrenaj” olarak adlandırılmıştır (Şekil 28).   
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SU TOPLAMA ALANI İŞLEMLERİ 

 

 

Şekil 28. Drenaj noktası seçimi 

Girilen nokta dikkate alınacağından “Batchdone”  0, girilen nokta tam drenaj çizgisi üzerinde 

değilse bu çizgiyi yakalaması için “Snapon” 1 ve girilen nokta su toplama alanının boşalım 

noktası olduğu için “Type” outlet olarak girilir (Şekil 29).  

 

Şekil 29. Drenaj noktası tanımı 

Girilen noktanın su toplama alanını belirlemek için yukarıda yapılan işlemlerden elde edilen 

katmanlar Şekil 30‘daki menüye girdi olarak girilir. Bu işlemden çalışma başında 

oluşturduğumuz poligon katmanı çerçevesinde Porsuk Çayı’nın Sakarya Nehri ile birleşim 

noktasına ait su toplama alanı elde edilir (Şekil 31).   
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Şekil 30. Girilen noktaya ait su toplama alanı katmanları 

 

Şekil 31. Su toplama alanı  

Sadece seçilen noktanın su toplama alanının görüntülenebilmesi “Layers” üzerine iki kere 

basılarak “Data Frame” seçilir. “Clip Options” bölümünde “clip to shape” seçeneği tercih 

edilerek “specify shape” basılır (Şekil 32).   
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Şekil 32. Seçilen noktaya ait su toplama alanının görüntülenmesi 

Burada “Outline of features” ile layers bölümünden drenaj sınırını içeren katman seçilerek 

“OK” tuşuna basılır (Şekil 33). 

   

Şekil 33. Seçilen nokta için çerçeve belirlenmesi 

Belirtilen noktada su toplama alanının büyüklüğü 10.834,84 km2 olarak hesaplanmıştır. Bu 

çalışmalar mxd dosyası olarak kaydedilir. 
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Şekil 34. Porsuk Çayı su toplama alanı 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 

39 
 

EK - 2 YENİ BİR DEPOLAMA TESİSİ İÇİN SU TOPLAMA ALANI  

Porsuk Çayı su toplama havzasında yeni bir yüzey suyu depolama tesisi yapılacağı zaman 

daha önceden oluşturulan mxd dosyası çağrılır.  

Point delination  tuşu ile yeni depolama tesisi inşa edilmesi tasarlanan yer, drenaj 

çizgileri üzerinde işaretlenir. Karşımıza gelen “point delineation” kutusunda daha önce 

hesaplanmış olan “porsukfdr”, “porsukstr”, “porsukcatcment” ve “ porsukadjointcatcment” 

katmanları kullanılır. Yeni oluşturulacak su toplana alanına çalışmamızda “A goleti” ismi 

verilmiştir (Şekil 35).  

 

Şekil 35. Yeni bir su toplama alanı belirleme 

Burada OK tuşuna bastıktan sonra tasarlanan su yapısı için su toplama alanı belirlenir (Şekil 

36) ve isim verilerek alan kayıt edilir 

Yapılan değişiklikler istenildiği takdirde mxd dosyasında kayıt edilir.  mxd dosyasını ilk 

açtığımızda point delineation için katmanları bir kez tanıtmamız yeterlidir. Bu dosya açık 

kaldığı sürece sadece point delineation tuşu ile istenilen nokta için su toplama alanı 

belirlenebilir.   

Buna benzer şekilde 5 farklı lokasyonda su depolama tesisleri (A, B, C, D ve E göletleri) için su 

toplama alanları belirlenmiştir. Belirlenen alanlara ait su toplama alanının büyüklüğü tablo 



 
 
 

40 
 

içerisinde “shape area” sütununa m2 olarak program tarafından otomatik olarak 

yazılmaktadır (Tablo 1). 

 

Şekil 36. A göleti için su toplama alanı 

 

Tablo 1. Göletlere ait su toplama alanının büyüklüğü 

 

 

Yapılan çalışmaların Porsuk Çayı su toplama alanı içindeki görüntüsü Şekil 37’de verilmiştir. 
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Şekil 37.  Su toplama alanları 
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EK – 3  BEYLİKAHİR GÖLÜ SU TOPLAMA ALANI 

Herhangi bir noktanın (nehirin denize boşalma noktası, bir akarsu kolunun başka bir akarsu 
kolu ile birleşim noktası veya baraj-gölet gibi depolama tesisi) su toplama alanının 
belirlenmesine benzer şekilde göl gibi alansal su kaynağının su toplama alanının da tespit 
edilmesi mümkündür. 
 
Yağışlardan kaynaklanan suların nehirleri besleyerek nehir havzalarını meydana getirdiği gibi 
bu tür suların gölleri beslediği alanlar göl su toplama alanı olarak ifade edilmektedir. 
Ülkemizde Konya Kapalı Havzası, Burdur Göller Havzası ve Van Kapalı Havzası nehir havzası 
karakterinde olmayıp göl havzası özeliğindedir.  
 
Bu örnekte Porsuk Çayı su toplama alanında bulunan Beylikahir Gölü su toplama alanı tespit 
edilmiştir. 
 
VERİ 
 
Porsuk Çayı su toplama alanında “akım yönü”nü belirleyen “porsukfdr” katmanı girdi olarak 
kullanılmıştır. Ayrıca göl alanının belirlenmesi için ArcCatalog’da porsuk.mdb içerisinde 
poligon oluşturularak mevcut göl alanı sayısal hale getirilir ve göl alanı bu poligon ile temsil 
edilir. 
 
SU TOPLAMA ALANI İŞLEMLERİ 

ArcHydro menüsünden  

 Watershed Processing Batch Watershed Delineation for Polygons seçilir.  

Akım yönünü içeren “porsukfdr” katmanı ile poligon özellikteki göl alanı katmanı olan 

“Beylikahir_golu” katmanı girdi olarak kullanılmıştır (Şekil 38). Elde edilecek su toplama alanı 

ise “Beylikahir” katmanı olarak kayıt edilecektir. 

 

Şekil 38. Su toplama alanı için gölün tanımlanması 

Elde edilen su toplama alanı Şekil 39’da ve bu alanın Porsuk Çayı havzasındaki yeri Şekil 40’da 

verilmiştir. 
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Şekil 39. Beylikahir gölü ve su toplama alanı 

 

 

Şekil 40. Beylikahir gölü ve su toplama alanının Porsuk Çayı havzasındaki yeri 
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2. COĞRAFİ BİLGİ SİSTEMLERİ İLE THIESSEN POLİGON METODU KULLANARAK  
DRENAJ ALANINA DÜŞEN YAĞIŞIN HESAPLANMASI 

2.1 Giriş  

Suyun ana kaynağı olan yağış verileri yağış istasyonlarında ölçüldüğünden belirli bir alanı 

değil, ölçüm noktasını temsil etmektedirler. Oysa çalışmalarda yağışın alansal dağılımının 

bilinmesi gereklidir.   Bu çalışma herhangi bir drenaj alanında ortalama alansal yağışın hesabı 

için geliştirilmiş olan Thiessen Metodu’nun ArcGIS 10 ile bir uygulamasını açıklamaktadır.  

Thissen Metodunda yağış istasyonlarının etki poligonları vardır. Bu etki poligonları geometrik 

olarak tanımlanır ve istasyonun o poligon içindeki yağış miktarı homojen kabul edilir.  

Birbirine yakın istasyonlardan oluşturulan üçgenlerin kenar orta dikmeleri çizilerek yağış 

istasyonlarının etki poligonlar bulunur. Bir istasyonun drenaj alanı içindeki etki poligon 

alanının, toplam drenaj alanına oranı o istasyonun etki ağırlığını vermektedir. Elde edilen etki 

ağırlığının ise istasyona ait yağış değeri ile çarpımı, o etki poligonuna düşen toplam yağış 

değerini belirtir.   

2.2 Bahçelik Barajı Örneği 

 

Bu çalışmada üretilecek katmanları bir geodatabase’de saklamak için “yagis.mdb” isimli bir 

personal geodatabase oluşturulur. Add data komutu ile yağış istasyonları ile ilgili bilgilerin 

yer aldığı “yagis_istasyon” katmanı ile havza sınırını belirten “drenaj_alani” katmanı zorunlu 

olarak ArcMap’e çağrılır. Buraya barak aks yeri ve drenaj alanı içindeki nehirleri de ilave 

edebiliriz. 
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ArcToolbox menüsünden; 

Analyst Tools → Proximity → Create Thiessen Polygon komutu seçilir.  

Input Feature olarak “yagis_istasyon” katmanı kullanılır. Çıktı dosyamız ise “yagis_poligon” 

ismi ile kayıt edilecektir.  
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İşlemi tamamlamadan önce yağış istasyonlarının temsil ettiği poligonları drenaj alanı 

çerçevesinde belirlemek için “Environment Settings” seçeneğinde “Processing Extent” 

menüsünden sınır olarak “drenaj_alani” katmanı seçilir. 

 

Elde edilen poligonlar aşağıda görülmektedir. 
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“yagis_poligon” katmanının tablosunda ise her bir poligonun alanı hesaplanmıştır. 

Hesaplamada drenaj alanının en uç köşe koordinatları dikkate alındığından alanlar drenaj 

alanı dışına taşmıştır.  
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Poligon alanlarının sadece drenaj alanı içinde kalan kısmını hesaplamak gereklidir. 

ArcToolbox menüsünden; 

Analyst Tools → Extract → Clip komutu seçilir.  

Input Feature olarak “yagis_poligon” katmanı kullanılır. Clip Features seçeneğinde 

“drenaj_alani” katmanı kullanılacaktır. Çıktı dosyamız ise “yagis_drenaj” ismi ile kayıt 

edilecektir.  

 Elde edilen drenaj alanı sınırları içerisindeki poligonlar aşağıda görülmektedir.  
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“yagis_drenaj” katmanının tablosunda ise drenaj alanı içerisinde yer alan her bir poligonun 

alanı yer almaktadır. 

 

“yagis_drenaj” katmanının tablosunda mouse ile “Shape_Area” sütunu üzerine gelip sağ tuşa 

basınca “Statistics” komutunda drenaj alanının toplamını Sum” satırında görebiliriz. Bu 

örnekte drenaj alanı 2798279681,93366 m2’dir. 
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Yağış miktarını hesaplamak için “yagis_drenaj” katmanına ait tabloya “yagis”, “etki_agirligi” 

ve “toplam_yagis” sütunları ilave edilir. Her istasyonun ortalama yıllık yağış değerleri girilir. 

 

Etki ağırlığı istasyonun temsil ettiği alanın toplam drenaj alanına bölümüdür. Bunun için 

“etki_agirligi” sütunu üzerinde sağ tuş ile “Field Calculator” seçilir. Buraya [Shape Area] /  

2798279681,93366 (toplam drenaj alanı) yazılır. Böylece her bir istasyonun etki ağırlığı 

hesaplanır.  
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Her bir yağış istasyonunun temsil ettiği alana düşen yağışı bulmak için ise “toplam_yagis” 

sütunu üzerinde sağ tuş ile “Field Calculator” seçilir. Buraya [yagis] * [etki_agirligi] yazılır. 

Böylece her bir yağış istasyonunun temsil ettiği alana düşen yağış miktarı hesaplanır.  

 

Bahcelik Barajı drenaj alanına düşen yıllık toplam ortalama yağış miktarını “yagis_drenaj” 

katmanının tablosunda mouse ile “toplam_yagis” sütunu üzerine gelip sağ tuşa basınca 

“Statistics” seçeneğinde Sum” satırında görebiliriz. Bu örnekte yıllık toplam ortalama yağış 

miktarı 396 mm’dir. 
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Her bir istasyon için alansak yağış değerlerini belirlemek için “yagis_drenaj” katmanına 

“istasyon_adi” sütunu ilave edilir. Satırlar seçilerek ekranda izlenir. Örnekte “OBJECTID” 

sütununda 1 olan değer Uzunpınar istasyonudur.  

 Böylece her bir “OBJECTID” değeri için istasyon adı belirlenerek ilave edilir. 
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3. COĞRAFİ BİLGİ SİSTEMLERİ İLE DEPOLAMA TESİSİ REZERVUAR HACMİNİN  
HESAPLANMASI  

3.1 Giriş  

Ülkemiz gibi yağış rejiminin zaman ve mekan olarak düzgün olmadığı yerlerde depolama 

tesislerinin inşası su kaynakları yönetimi açısından önemlidir. Bu nedenle, akarsu debilerinin 

bol olduğu, ay, mevsim yada yıllardan, suların kıt olduğu, ay, mevsim yada yıllara suyun 

aktarılması gerekir. Bu da depolama tesislerinin inşaası ile gerçekleştirilir.   

Öncelikle akarsuyun akım değerleri ve ihtiyaç duyulan su miktarı bir arada değerlendirilerek 

su ihtiyaçlarının en ekonomik bir şekilde karşılanabilesi için çeşitli yöntemler kullanılarak 

maksimum su kotu ve su kotuna bağlı olarak depolanacak su hacimi belirlenir.  

Bu çalışmada belirlenen su kotuna bağlı olarak rezervuar hacmi hesaplanmıştır. 

3.2 Bahçelik Barajı Örneği 

 

3.2.1 Rezervuar hacminin hesaplanması 

Örnekte 1/25000 ölçekli harita münhanilerinden elde edilen raster veri kullanılmıştır. Raster 

veriyi üretmek için Bahçelik Barajı göl alanının yer aldığı  k36c1 ve k36c2 paftaları gereklidir. 

Add data komutu ile çalışma alanının yer aldığı k36c1 ve k36c2 paftalarına ait eş yükseklik 

eğrileri ArcMap’e çağrılır.  

 

ArcToolbox menüsünden; 

3D Analyst Tools →TIN Management → Create TIN komutu seçilir.  
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Çıktı dosyamızın (bahcelik) kayıt edileceği klasör Output TIN hanesinde belirtilir. Spatial 

Reference için eş yükseklik eğrileri katmanından projeksiyon tanımı yapılır. Input Feature 

Class seçeneğinde ise dana önce ArcMap’e çağırdığımız katmanlar kullanılır. “height field” 

hanesinde paftalara ait tablodan yükseklik değerlerinin yer aldığı sütun, “SF_type” hanesinde 

ise hardline seçenekleri tercih edilir. 

 

Elde edilen TIN aşağıda görülmektedir. Çalışma alanında minimum arazi kotunun 1440 

metre, maksimum yüksekliğin ise 2320 metre olduğu görülmektedir. 

 



 
 
 

56 
 

Bu bahçelil isimli TIN katmanında sağ tuş ile “Layer Properties” üzerinde gelip “Symbology” 

menüsünden “Edge types” kutusundaki çizik kaldırılınca TIN üzerindeki münhaniler 

gözükmeyecktir.  

 

Elde edilen TIN aşağıda görülmektedir. 

 

ArcToolbox menüsünden; 

3D Analyst Tools →Conversion → From TIN → TIN to Raster komutu seçilir.  
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Input TIN seçeneğinde elde ettiğimiz bahçelik dosyası girdi olarak kullanılır. Çıktı dosyamızın 

(bahçelik_r) kayıt edileceği klasör Output Raster hanesinde belirtilir. “Sampling Distance” 

hanesine çalışmada hassasiyeti arttırmak için CELLSIZE 10 girilir. Burada elde edilecek raster 

tabakasında hücre boyutları 10 metre x 10 metre olacaktır. 

 

Elde edilen Raster aşağıda görülmektedir.   

 

ArcToolbox menüsünden; 

Spatial Analyst Tools → Surface → Contour List komutu seçilir.  

Input raster seçeneğinde elde ettiğimiz “bahçelik_r” dosyası girdi olarak kullanılır. Çıktı 

dosyasının “aktifhacim_k” kayıt edileceği klasör Output Polyline Feature hanesinde belirtilir. 
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Çıktı dosyası vektör özelliğinde olduğundan bu işlemden önce personal geodatabase 

oluşturulur (baraj.mdb). Barajın maksimum su kotu 1500 metre olduğuna göre Contour 

values olarak 1500 girilir. 

 

Elde edilen maksimum su kotu aşağıda görülmektedir. 

 

Aktif hacim alanını çizmek için “aktifhacim_a” isminde poligon özelliğinde bir feature class 

oluşturulur. Aks yeri belirlendikten sonra line özelliğindeki su kotu üzerinden trace komutu 

ile gidilerek aks yerinde çizgiler kapatılır ve baraj göl alanını gösteren poligon elde edilir. 
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ArcToolbox menüsünden; 

Spatial Analyst Tools → Extraction → Extract by Mask komutu seçilir.  

Input raster seçeneğinde “bahçelik_r” dosyası girdi olarak kullanılır. Bu rasterdan aktif 

hacmin kapladığı göl alanını kesmek için feature mask data hanesine “akifhacim_a” poligonu 

girilir. Output raster hanesinde ise çıktı dosyası “aktifhacim_r” olacaktır.  
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Elde edilen aktif hacim göl alanı aşağıda görülmektedir.

 

Maksimum su seviyesinin altında kalan hacmi bulmak için  

ArcToolbox menüsünden; 

3D Analyst Tools → Functional Surface → Surface Volume komutu seçilir.  

Input surface seçeneğinde “aktifhacim_r” dosyası girdi olarak kullanılır. Output text file 

hanesinde çıktı dosyası “aktifhacim.txt” olacaktır. 1500 metre kotunun altında kalan 

maksimum hacmi hesaplayacağımız için “Reference Plane” hanesinde “BELOW” seçilir. 

“Plane Height” hanesine ise maksimum su kotu olan 1500 metre girilir.  
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Çıktı dosyasının içeriği aşağıda görülmektedir.  

Dataset, Plane_Height, Reference, Z_Factor, Area_2D, Area_3D, Volume 

K:\bahcelik\aktifhacim_r, 1500.00, BELOW, 1.000000, 11802956.963396, 11924473.399534, 

212157654.89807  

Böylece aktif hacim yaklaşık 212 milyon m3 olarak hesaplanmıştır. 
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4. COĞRAFİ BİLGİ SİSTEMLERİ İLE DEPOLAMA TESİSİ REZERVUARINA AİT KOT-
ALAN-HACİM GRAFİĞİ İÇİN VERİ HAZIRLANMASI  
 

4.1 Giriş  

Kot-alan-hacim grafikleri su seviyesine bağlı olarak rezervuar alanındaki ve hacmindeki 

değişimlere ilişkin verileri ortaya çıkarmaktadır. Bu grafikler, rezervuarların yıllık işletme 

programlarının hazırlanmasında önem arz etmektedirler. 

4.2 Bahçelik Barajı Örneği 

 

Bölüm 3’de Bahçelik Barajı göl alanının yer aldığı  k36c1 ve k36c2 paftaları ndan üretilen 

raster veri kullanılmıştır.  

Kot-Alan-Hacim grafiği için 1452 m. kotundan 1504 m. kotuna kadar çeşitli aralıklarda 20 

farklı kot değeri için alan ve hacim hesabı yapılmıştır.   

Konturları çizmek için; 

ArcToolbox menüsünden; 

Spatial Analyst Tools → Surface → Contour List komutu seçilir.  

Input raster seçeneğinde “bahçelik_r” dosyası girdi olarak kullanılır. Çıktı dosyası için 

belirlenen aralıklarda kot_1452 olacak şekilde işlem yapılır (Bölüm 3’de açıklanan aktif hacim 

kotunun belirlendiği yol takip edilir). Elde edilen konturlar aşağıda görülmektedir.  
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Konturlardan alan elde etmek için; 

Belirlenen kotlardaki alanı çizmek için 20 adet “alan_1452” gibi poligon özelliğinde feature 

class oluşturulur. Aks yeri belirlendikten sonra line özelliğindeki su kotu üzerinden trace 

komutu ile gidilerek aks yerinde çizgiler kapatılır ve belirlenen kotlar için baraj göl alanını 

gösteren poligon elde edilir (Bölüm 3’de açıklanan aktif hacim kotundan alanın belirlendiği 

yol takip edilir). Poigonların farklı renklendirilmesi halinde aks yerinde aşağıdaki görüntü elde 

edilir.  
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Göl alanlarını 3 boyutlu olarak raster veri setinden belirlemek için;  

ArcToolbox menüsünden; 

Spatial Analyst Tools → Extraction → Extract by Mask komutu seçilir.  

Input raster seçeneğinde “bahçelik_r” dosyası girdi olarak kullanılır. Bu rasterdan belirlenen 

kotlardaki göl alanını kesmek için feature mask data hanesine elde edilen poligon adları 

girilir. Çıktı dosyası “raster_1452” gibi olacaktır (Bölüm 3’de açıklanan raster veri setinden 

aktif hacim alanının kesildiği yol takip edilir). Elde edilen sayısal yükseklik modelleri aşağıda 

görülmektedir. 
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Yukarıdaki şekilde 1496 metreden geçen su kotunu kestiğimizde raster veride maksimum 

değerin 1508,58 metre olduğu ve istenilen değeri 12,58 metre aştığı görülmektedir.  1496 

metre kotunu temsil eden alan vektör özelliktedir. Dolayısıyla raster veriden vektör veriyi 

keserken, vektör veri piksellerden oluşan raster veri üzerine getirilir. Vektör çizginin yüksek 

kot değerine sahip piksele teması halinde bu değer dikkate alınır. Ancak bir sonraki aşamada 

göl hacmi hesaplanırken 1496 metre su kotunun altında kalan hacim hesaplanacağından 

otomatik olarak 1496 metre üzerinde kalan değerler hesaba katılmayacaktır.   

Ayrıca 1496 metre su kotuna göre alan çevirdiğimizde göl alanında iki ada oluştuğu aşağıdaki 

şekilde görülmektedir. Bu adaların kot değerleri 1496 metreden fazladır. Hacim hesabında bu 

adaların kapladığı alan dikkate alınmayacaktır. 
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Belirlenen su seviyesinin altında kalan hacmi bulmak için;  

ArcToolbox menüsünden; 

3D Analyst Tools → Functional Surface → Surface Volume komutu seçilir.  

Input surface seçeneğinde “raster_1452” gibi elde edilen raster dosyalar girdi olarak 

kullanılır. Output text file hanesinde çıktı dosyası “hacim_1452.txt” olacaktır. 1452 metre 

kotunun altında kalan maksimum hacmi hesaplayacağımız için “Reference Plane” hanesinde 

“BELOW” seçilir. “Plane Height” hanesine ise maksimum su kotu olan 1452 metre girilir 

(Bölüm 3’de açıklanan aktif hacmin belirlendiği yol takip edilir). 

Konturları çizmek, konturlardan alan elde etmek, göl alanlarını 3 boyutlu olarak raster veri 

setinden kesmek ve belirlenen su seviyesinin altında kalan hacmi bulmak için yukarıdaki 

işlemler 1452 m ila 1504 m arasında belirlenen 20 farklı kot için tekrar edilmelidir. Belirlenen 

kotlar için elde edilen alan ve hacim değerleri ve grafiği aşağıda görülmektedir.  
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Kot 
(m) 

Alan (m2) Hacim (m3) 

1452 25,004.75 43,892.47 

1456 564,231.49 685,167.21 

1460 1,183,323.19 4,055,884.02 

1464 1,695,391.32 10,064,733.85 

1468 2,443,098.88 18,696,695.56 

1472 3,193,946.73 30,421,536.44 

1476 3,663,065.96 44,502,378.05 

1480 4,761,778.30 60,712,196.61 

1482 5,187,183.69 70,962,403.59 

1484 5,559,541.81 82,165,529.35 

1486 6,145,672.92 94,292,446.66 

1488 6,576,452.17 107,393,508.50 

1490 7,322,268.72 121,678,795.56 

1492 7,830,949.09 137,361,744.43 

1494 8,259,599.62 153,920,834.20 

1496 9,061,433.38 171,704,445.60 

1498 9,753,917.61 191,318,145.41 

1500 11,802,956.96 212,157,654.90 

1502 11,811,976.50 235,783,248.48 

1504 11,812,184.45 259,409,993.46 
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5. COĞRAFİ BİLGİ SİSTEMLERİ İLE DRENAJ ALANINA AİT KOT-ALAN GRAFİĞİ 
İÇİN VERİ HAZIRLANMASI  

5.1 Giriş  

Kot-alan grafikleri, drenaj alanında belirlenen yükseklik aralıklarına ait alanları yüzde olarak 

vermektedir. Bu grafikler hidrolojide genellikle iki amaç için kullanılmaktadır. Kar erimesi ile 

meydana gelebilecek su miktarının hesaplanması ilk amacı oluşturmaktadır. Burada kar ile 

kaplı alanın alt sınırı belirlenerek drenaj alanında kar ile kaplı alanın büyüklüğü 

hesaplanmaktadır.  

 

Diğeri ise havzada yer alan yağış istasyonlarının yükseklik olarak havzayı temsil edip 

etmediğinin belirlenmesidir. Bunun için yağış istasyonları kot-alan grafiği üzerine 

işaretlenerek yağış değerlerinin havzayı temsil edip etmediğine karar verilir. Yağış 

değerlerinin drenaj alanını temsil etmediği takdirde, değerler arası korelasyon katsayıları, 

istasyonların kotları göz önünde bulundurularak incelendiğinde yağış-yükseklik ilişkisi 

incelenir. Bu ilişki varlığı gözlemlenirse yağışın yüksekliğe göre dağılımı yapılmalıdır. 

 

5.2 Bahçelik Barajı Örneği 

 

Herhangi bir drenaj alanına ait kot-alan grafiğinin CBS ile elde edilmesi için sadece drenaj 

alanına ait sayısal yükseklik modeli (DEM) gereklidir. Bu çalışmada SRTM veri seti 

kullanılmıştır. Bahçelik Barajı drenaj alanını SRTM görüntüsünden kesmek gerekir. 

 

ArcToolbox menüsünden; 

Spatial Analyst Tools → Extraction → Extract by Mask komutu seçilir.  

Input raster seçeneğinde “SRTM” veri seti girdi olarak kullanılır. Bu rasterdan barajın drenaj 

alanın temsil eden alanı kesmek için feature mask data hanesine “drenaj_alani” katmanı 

girilir. Output raster hanesinde ise çıktı dosyası ”kot_alan_r” raster katmanı olacaktır. 
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Elde edilen drenaj alanına ait sayısal yükseklik modeli aşağıda görülmektedir. 
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ArcToolbox menüsünden; 

3D Analyst Tools → Raster Reclass → Reclassify komutu seçilir.  

Input raster seçeneğinde “kot_alan_r” dosyası girdi olarak kullanılır. “Old values” hanesine 

rasterdaki mevcut değerler gelecektir. Amaç belirlenen yükseklik aralıklarındaki alan 

büyüklüğünü bulmaktır. Classify tuşuna basarak aralıklar belirlenir. Output raster hanesinde 

ise çıktı dosyası “kot_alan_rcl” olacaktır.   

 

“Method” seçeneğinden aralıkları belirlemede kullanılacak metotlar seçilebilir veya “Classes” 

seçeneği ile aralık sayısı belirlenerek “Break Values” hanelerine ise bu değerler girilir. 

Örnekte 1452 metre ila 2708 metre arasında 6 aralığın yeterli olacağı düşüncesi ile minimum 

ve maksimum seviye arası 6’ya bölünmüştür. Bu nedenle değerler 200’er metre artışlı olarak 

girilmiştir. 
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OK tuşuna basılır. 

“New values” hanesine bölünen aralıkların üst kotları girilir.  
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Elde edilen çıktı aşağıda görülmektedir.

 

ArcToolbox menüsünden; 

Conversion Tools → From Raster → Raster to Polygon komutu seçilir.  

Input raster seçeneğinde “kot_alan_rcl” dosyası girdi olarak kullanılır. Output raster 

hanesinde ise çıktı dosyası “kot_alan” olacaktır.  Bu işlemde raster katman poligon vektör 

hale getirilir. Bunun için öncelikle “kot_alan.mdb” oluşturulur. 
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Elde edilen “kot_alan” katmanının tablosu aşağıda görülmektedir.

 

Bu tablodaki değerler seçilerek “Copy Selected” tuşu ile kopyalanır. 
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Excel dosyaya değerler yapıştırıldıktan sonra her bir kot aralığına karşı belirlenen alanlar 

toplanır. Kümülatif değerler belirlendikten sonra alan yüzdeleri hesaplanarak kot değerlerine 

karşı grafiğe çizilir. 

Bahçelik Barajı su toplama alanında 3 adet yağış istasyonu yer almaktadır. İki istasyon 

kapatıldığı için havza sınırına çok yakın olan Uzunpınar istasyonu değerlendirmeye alınmıştır. 

Bu istasyonlara ait veriler aşağıda verilmiştir; 

 
İstasyon adı 

 
Kot (m) 

Yıllık 
ortalama 

yağış (mm) 

İstasyon açılış 
tarihi 

İstasyon 
kapanış tarihi 

 
Başören 

 
1670 429 1966  

 
Kazancık 

 
1050 270 1962 1973 

 
Yedioluk 

 
1790 612 1966 1973 

 
Uzunpınar 

 
1740 301 1959  
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Havzada en yüksek kotta olan Yedioluk istasyonudur. Bu istasyon kot-alan grafiğine işlendiği 

takdirde havzanın yaklaşık % 85’inin yağış istasyonlarınca temsil edilmediği görülmektedir. 
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